Optimizing PCC EHR:
Workflow & Configuration Improvements
You Can Use Today
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Goals of this Course

e PCC EHR changes constantly and we are always adding
new and exciting features that can help optimize your

use of PCC EHR.
e This course will focus on some of the new PCC EHR

functionality, providing you with takeaways that you
can begin using at your practice. /./’
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Managing Patients/Accounts
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Add Patients/Accounts in PCC EHR

e Itis possible to add patients, add accounts and
reassign accounts in PCC EHR!
e The Assign Account option is available in the patient

demographic section
e The Add Patient or Add Account option is only visible
after you have performed a search for a patient or

account
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Add Patient

Search Results for
= # | PCP | Patient Flags
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Add Patient

PCC EHR _
= “I T Create Patient
~|| FIND

Patient Demographics

Patient Information

First Name: [Han | Patient Flags: | -
Nickname: ( | PCP: ( -
Middle Name: | | SSN: | |
Last Name: Solo | School: ( |
Suffix: Jr ] Alt Name: [ ]
Date of Birth: [05/16/89 ] Chart #: ]
Sex: Male \.] Relation to Bill Payor: [ |.]
Deceased: @ No OYes [enterdate ]

Birth History

GA at Birth: [:] weeks days

Multiple Birth: No O Yes | [~]

Race, Ethnicity, and Preferred Languag

Race: .]

Ethnicity: v

Pref. Language: [ ]:]E]

Account Demographics

No Home and Billing Account

PCC Tn',...!.;
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Add Patient
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Reassign Patient Account(s)

Demographics ‘Train Adam Hamann 5 yrs, 3 mos 3/0.. .~ |

L < J L J

@ No Preference

Account Demographics

Home and Billing Account Account Information

Elaine B. Hamann (Account # 1612) Account Flags: [ H
First Name: [Elaine B. ] EMG Contact: | |
Last Name: [Hamann ] EMG Phone #: [ ]
Address Alt Last Name: [ ]
153 East Cherry Street | MotherssN: | ]
[address 2 Father SSN: [ ]
[Readsboro }[v’r H[05350 ] Pharmacy #: [ ]
Phone Recent Financial History

Last Service: 04/14/17
Last Bill Sent:

Last Pers. Pmt: 04/14/17
Last Ins. Pmt:  05/02/17
Hold Bill Until: [

Budget Amt: ¢

Primary: [802-555-0108
Secondary: [802-555-0190
Text Phone: [302-555-0174
Emg Phone: |§02-555-0163

Email: [

PCC
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Add New Account

4 Reassign Account X
Reassign Account Train Adam Hamann 5 yrs, 3 mos 3/05/12 M
Account Finder Current Home Account: Elaine B. Hamann (Account # 1612)
Select an account to be assigned to the patient. Current Billing Account: Elaine B. Hamann (Account # 1612)
[ham |~] | Find
Search Results for Name: ham
Last First Last Service |Address Account # |Account Flags
Hamann Elaine B. 04/14/17 153 East Cherry Street, Readsboro, VT 1612
Hamann Timothy 04/26/17 35 Prospect Street, Putney, VT 1301
Hamilla Randy  04/26/17 578 Springbrook Drive, Orleans, VT 787
Hamilton Steven 03/01/17 554 W Granada Ave, Richford, VT 389
Hammond Michael 92 University Manor East, Coventry, VT 459
Create Account | | Cancel ’ ( Select ]
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PCC

Add New Account

£ Reassign Account

Reassign Account

‘Train Adam Hamann 5 yrs, 3 mos 3/05/12 M

Create Account
Account

First Name: [Denise

Last Name: [Hamann

Address

[12345 Main Street

[aridr'es:i 2

[Burlington

Phone

Primary: [802-340-2039

Secondary: [

Text Phone: [

Emg Phone: [

Email: [

Account Information

Account Flags: {

EMG Contact:

EMG Phone #:

Mother SSN:

{
{
Alt Last Name: {
[
Father SSN: {

Pharmacy #: {

Recent Financial History
Last Service:

Last Bill Sent:

Last Pers. Pmt:

Last Ins. Pmt:

Hold Bill Until:

Budget Amt: [$

{ Back HCancel H Save ]
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Reassign Account Options

Reassign Account Train Adam

Selected account:
Denise Hamann (Account # 4014)

Assign as:

() Home Account

_ Billing Account

® Home and Billing (Current Account: Elaine B. Hamann (Account # 1612))

ol

PCC

T Pediatric EHR Solutions




Policies in PCC EHR

e Users can edit, add, and expire policies in PCC
EHR.

Policies \Edit Policy |Add Policy Display. | Active - |

Insurance ‘ Copay ‘ Certificate ‘ Group ‘ Start | End | Status
i» 1 Aetna HDHP $15.00 34DFJH 10/13/15 Acti
$0.00 123456789 06/18/18

PCC
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Policies in PCC EHR

Add Policy I } [X]
Add Policy .

| pwrt ® daClive plans 1rom
Copay: Autofill Last Modified: Aetna PPO 20% (PO Box 981106, El Paso, TX 79998-1106)

Certificate: | Autofill Dino's Policy: Aetna HDHP (PO Box 981106, El Paso, TX 79998-1106)

Aetna EPO $10 Box 91522 (PO. Box 91522, Arlington, TX 76015-0022)
Group Aetna EPO $15 Box 91522 (PO. Box 91522, Arlington, TX 76015-0022) a r n e r a re S e a rc a e
StartDate: | Aetna HDHP (PO Box 981106, El Paso, TX 79998-1106)
1 Aetna MC $10 Box 1125 (PO Box 1125, Blue Bell, PA 19422)
. EndDate Aetna MC $15 Box 1125 (PO Box 1125, Blue Bell, PA 19422)

L]
: Aetna MC $15;Full WC (PO Box 1125, Blue Bell, PA 19422) . ( a n a to _fl | | I a St
. Subscriber: |Aetna MC $25 (PO Box 1125, Blue Bell, PA 19422) - ' I

First Name: 52

G — modified or sibling’s
policy info

! Address: address

city state |~ | zip code
Add |
Employer:

cate Group
Pt. Relationship to Subscriber: |select a relationship hd

1106

Jc at 1-800-345-1284 ext 1117
Cancel Save
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Policies in PCC EHR

Add Policy [X]

ﬁ::rap:clti:y @ Medicaid - Payer ID . M e d I Ca I d p I a n S a re

opay: $0.00
Certificate : 123456789 ! : i1 1)
denoted with an "M
StartDate:  [06/18/18 |

T — e These plans auto-fill

7 Subscriber:
irst 3 ebbles v . . .
LastName: Flintstone patlent Info In
! Date of Birth: /08

eeeeee

P subscriber section

EEEEEEEEE

aaaaaaaaaa
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Personal Contacts

e Personal Contacts is EHR-only

e Additional contacts (including additional parents) for
the patient can be added with contact information and
notes.

Personal Contacts
Personal Contacts have not been entered.

select a personal contact

Add Patient Contact
Kevin Setlock (Custodian)

L T R . R R iy B
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Personal Contacts

Personal Contacts

Karen Setlock (Maternal Grandmother)
Phone: 240-304-3049

NOte: | watches Carrie after school. Can bring in for appts and call with questions |

EDIT CONTACT | | REMOVE |

select a personal contact Ij

il
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Copy Notes to Siblings

e The following components on the medical summary
can be copied between siblings:

o Medical History, Social History, Family Medical
History, Reminders

e There are two options to access the option to copy

notes:

o Click Edit>Copy Notes to Siblings

o Right-click on the component you want to copy /’“’L
PCC.. oo J"‘
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Copy Notes to Siblings

File | Edit| Reports Tools Help
Add Protocol
Change Protocol

ical Summary
us |

Remove Protocol

Add Amendment Request e Allergy Cat Hair (4

Add Phone Note

Delete Phone Note
Add Portal Message )
Delete Portal Message

eRx Allergies Upc

Copy Notes to Siblings
Find

Find Next
Allergies

PCC eRx Allergies
Medication History Care Plan

ication History U

PCC
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Copy Notes to Siblings

Family Medical History Modified 06/17/16

Condition Relationship Note

Eczema Brother

Anemia §Matemal4 Copy Family Medical History to Siblings | ‘
Epilepsy Maternal Uncle, Mother

il
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Copy Notes to Siblings

% Copy Notes to Si

ngs

]
Copy Notes to Sibilings

From: Train Pebbles Flintstone 10 yrs, 1 mo 5/15/06 F
Family Medical History

Condition | Relationship | Note
Eczema Brother
Anemia Maternal Aunt, Paternal Grandmother
Epilepsy Maternal Uncle, Mother
To: | Train Dino Flintstone 4 yrs, 2 mos 3/24/12 M
@ Append () Replace () Custom () Do Not Copy Notes for this Patient
Family Medical History
Condition | Relationship | Note
Eczema Brother
Anemia Maternal Aunt, Paternal Grandmother
Epilepsy

Maternal Uncle, Mother

[ Back H Save ]| Cancel |
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Working with Documents
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Documents in PCC EHR

e Possible to create a task from the Import Documents
screen

e Tasks visible on Messaging queue and in patient’s chart

e |f a document has been set to require a provider's
signature, the document can now be signed from
anywhere the document is viewed
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Create Task in Import Documents

~ 1ags
Needs to be Signed by Provider: [
lseW%Ct a provider I"

[] Display in Portal Documents
Document will be visible to all portal users
attached to the patient

Note (Internal use)

| I

¥ Tasks: 1 (0 Completed)

) Task:

[FYI v
To:

[Elizabeth Casey, M.D. t}
Note:

| |
[] Task Completed

oy: [sefect s s [
At: [mmydd/yy | [12:00am |

E).C—.C Pediatric EHR Solutions




Document Task in Messaging Queue

| Schedule (3) | Visit Tasks (4) | Rx Queue (0) | Messaging (12) | Signing (76) | Appt Book |

Date | Patient | Subject Task |To M

06/09/17 11:51am Flintstone, Pebbles gDocument - Lab result Elizabeth Casey, M.D.

06/07/17 7:53pm Flintstone, Pebbles Document - radiology Call Parent with Result Joan Abbott, NP B

ol
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Viewing Document Task

- 1ays

¥ Tasks: 2 (1 Completed) |

o Task:

[FYi |+
To:

[Elizabeth Casey, M.D. ]:]
Note:

l Patient should be called with results. ]

(%] Task Completed

By: [Elizabeth Casey, M.D. |:]

At: [06/09/17 |[11:53am

) Task:

[Call Patient with Result lj

To:

|Alice Normand| |~

Note:

[ ] Task Completed

By:[, lect a use Iv]
PCC At: [mm/ddlyy ] [12:00am
el
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Patient Demographics Included

-Tags -

&) Task:

[Call Patient with Result t]
To:

[Alice Normand t]
Note:

[] Task Completed

oy s B

At: i 12:00am

P Communication Preferences

¥ Account Demographics

Home and Billing Account
Wilma & Fred Flintstone-Smith (Account

#1981)
Address
15 Quarry Lane
Colchester,VT05446
Phone
Primary: 802-655-1234
. . . Secondary: 802-555-0197
Pediatric EHR Solutions Text Phone: 802-555-0161

.- . Emg Phone: 802-555-0168




Task Visible in Documents Screen

Documents Pebbles Flintstone 11 yrs, 1

» Correspondence/Consults (1)
» Demographics (1)

» General (1)

» Hospital (1)

» Insurance/Billing (1)

v Lab (1)

Title: Lab result
Category: Lab
Attached to: 05/11/17 - Sick - Bright Futures
Lab - Influenza A/B
W Tasks: 2 (1 Completed)
o Task: FYI
To:  Elizabeth Casey, M.D.
Note: Patient should be called with results. [pcc 06/09/17 11:53am]
COMPLETED [elizabeth]
) Task: Call Patient with Result
To: Alice Normand

Last Modified: pcc 06/09/17 11:54am

PCC
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PCC

Edit/Sign Document

Pediatric EHR Solutions

-Tags

Title: Lab result
Date: 05/11/17
Category: Lab
Pages: 1

Attached to: 05/11/17 - Sick - Bright Futures
Lab - Influenza A/B

¥ Tasks: 2 (1 Completed)
o/ Task: FYI
To: Elizabeth Casey, M.D.
Note: Patient should be called with

results. [pcc 06/09/17 11:53am]
COMPLETED [elizabeth]

) Task: Call Patient with Result
To: Alice Normand

P Communication Preferences
P Account Demographics

Last Modified: pcc 06/09/17 11:54am

[ Print H Sign H Edit H Close l




Keep Documents Open as You Chart

ece PCC EHR

PCC EHR Sick - Bright Futures Shaquana Padrone 16yrs,9mos 6/20/01 F
I TN i

Order  Rapid Strep

Order | Urine dipstick
Medical Summary e Document Viewer Shaquana Padrone 16yrs,9mos 6/20/01 F
Demographics Order  CBC
r

— EOTING | © Lead Screen Ordered TO: Alice Normand - 206 awack srxEr
PCC eRx DETAILS® REVERE, XA 02351

Facility: | Uptown Laboratories - Order Date: 04/05/18 - i st

Specimen Collected: By 12:00 AM = T

Test Result Units  Reference Range Interpretation | ALL NORMAL .‘_"_“ oolodsie

et ) | G o e - Belectinterpeetation - .

Capillary { - b T 1on 8

Condition/Disposition: seiect a condition o'dspos.:ano'}_ e gk

Note: | enter notes Below Low Normal Slced Lead Comoeatraticm: < pa/dn

Signature Requi Refused | Low Urgent - .
d Below Lower Panic Limits T latmrpeetation of rediatric Test Resulta: 4
L o P Above High Normal Miood Lead Concentration:
¥ Tasks: 1 (0 Completed) High Urgent
Above Upper Panic Limits Yevels n this rame are balow the threshold
© Task Collect Specimen ~ | Tol Very Abnormal - . . .
Note | enter task notes here - G -—
Task Completed At 12:00am | By : < 2 5
Placing windows side-by-side i -
allows you to easily copy data <« Pagelof1 »
ADO TASK DISCARD CHANGH  from an imported document
into the patient's chart 1abPNG  04/03/18 05:45pm

Order select a lab

Rotate Page Rotate Document Fit Width - + Zoom to Fit

Medical Test
Order

Print Sign Edit Close

select a medical test

T T Pediatric EHR Solutions




Show Documents in the Patient Portal

e When importing a [:*EI |
document to a patient’s R B
chart you can choose i B
to show the document T B
in the patient portal e

e Fill out the Title note .
box so that the .
document in the portal SE R s

PCC Pe |at|r!c| ng\élgtgnslabel




Communicating w/Patients & Families
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Portal Users Component

e You can use the Patient Portal Users component in PCC
EHR to quickly review portal information and help get
all of your families using the patient portal.

e The component allows you to manage protal users and
can confirm whether portal balances are enabled &

privacy is enabled. /I,ll
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Portal Users Component

Patient Portal Users
Manage Portal User

Name:  Wilma Flintstone
Email: wilma@bedrock.com
Phone:  800-722-1082

Balances: Personal balances not displayed

Manage Portal User

Name: Fred Flintstone
Email: fred@bedrock.com
Phone:  800-722-1082

Balances: Fred Flintstone (Account # 1980)

Add Portal User

Last Login: 07/11/18 11:30am
Unread Messages: 0
Unviewed Documents: 0

Last Login: never
Temporary Password: WSyeHRcv "
Unread Messages: 0 Review portal users who

can view this patient, along
with their recent activity

Unviewed Documents: 0

PCC
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Portal Users Component

Patient Portal Users
This patient has no associated portal users.

Add Portal lkjser j

Add Portal User Add Portal User

Manage Portal User
*Email Address: wilma@bedrock.com
*First Name: Wilma
*Last Name: Flintstone

Phone Number: 800-722-1082

*required

| Clear | Add yser |

Sign In details will be automatically sent to the Portal User's email address.

PCC
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Portal Users Component

Open the Patient Portal Manager
to reset a password, adjust
patient access, and more

P RPN U I AT P TR M g e

Manage Pgrta Ser’ Name:  Fred Flintstone Last Login: never
Email:  fred@bedrock.com Temporary Password: WSyeHRcv
Phone:  800-722-1082 Unread Messages: 0

Balances: Fred Flintstone (Account # 1980)  Unviewed Documents: 0

Manage Portal User: Fred Flintstone | Back |

Edit Portal User Delete Portal User

Portal User Name: Fred Flintstone
Email Address: fred@bedrock.com
Phone Number: 800-722-1082
Temporary Password: WSyeHRcv Print Password Reset Password
Patients connected to this portal user | Add siblings || Add Patients
Name Hideat o pge PCC # Custodian
age 18
remove Dino Flintstone Yes 04/24/14 4y 2m 3335 Wilma Flintstone

Select billing account for personal balance display
The balance will not include charges for patients in jtalics. These patients have privacy enabled or are not connected to
the portal user.

© Fred Flintstone
Patients: Dino Flintstone, Pebbles Flintstone

.. . PediatriC EHR SOlUtionS Do not display balance




Portal Users Component

Patient Portal Users

Manage Portal User|  5ge-hased privacy is enabled. Patient information cannot be viewed by this portal user.

Name:  Terry Manning Last Login: 07/19/18 11:36am
Email:  tmanning@kobolds.net Unread Messages: 0
Phone: Unviewed Documents: 0

Balances: Kevin M Manning (Account # 56)

Manage Portal User  nName:  wilma Flintstone Last Login: 07/11/18 11:30am

Email: wilma@bedrock.com Unread Messages: 0

: -1082 Unviewed Documents: 0
Balances: Personal balances not displayed)

Wilma Flintstone does not see personal
balances in the portal for this patient. If
she should, you can click “Manage
Portal User” to adjust

PCC
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Attach Documents to Portal Messages

Portal Message Abigail Addington 9yrs, 11 mos 5/03/09 F

Portal Messages

Subject: Tips for Getting Started with Diabetes Management? MOl enter use

Date: 05/02/19 1:39pm
From: Ansel Addington
Phone: 802-846-8177

Hi Dr.,
Abigail's grandmother (who watches Abb after school) wanted to learn what she should know about her diagnosis.

Anything useful to share?
-Ansel

Reply

Hello,
Our care coordinator can talk with Abigail's grandmother, either over the phone or you can schedule time to talk in person.

I've attached the handout that we provided at our last appointment.
Call the office (800-722-1082) or send a message for our scheduler, and we can set up an appointment.

-Nurse Mark

Add Attaghment No Reply Send

PCC
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Attach Documents to Portal Messages

[ N ] «+ Add Attachment
Add Attachment
» Recent Documents (5) Use the Recent Documents list
to find something quickly, or
> Cor.respondenc_:e/ConsuIts (4) pick from a document category
¥ Patient Education (2)
— Title: Type 2 Diabetes Tips
— Category: Patient Education Pages: 2
Portal: Available in Portal Documents
Last Modified: niark 05/02/19 1:43pm
ro— Title: Connected Kids: Friends Are Important: Tips For
- Parents
Category: Patient Education Pages: 3
Portal: Available in Portal Documents
o Last Modified: mark 05/02/19 1:43pm

E Cancel || Attach

2R B Pediatric EHR Solutions




Attach Documents to Portal Messages

Portal Message Abigail Addington 9yrs, 11 mos 5/03/09 F

Portal Messages

Subject: Tips for Getting Started with Diabetes Management? TO |enter user

Date: 05/02/19 1:39pm
From: Ansel Addington
Phone: 802-846-8177

Hi Dr.,

Abigail's grandmother (who watches Abb after school) wanted to learn what she should know about her
diagnosis. Anything useful to share?

-Ansel

Reply
Hello,

Our care coordinator can talk with Abigail's grandmother, either over the phone or you can schedule time to
talk in person.

I've attached the handout that we provided at our last appointment.

Call the office (800-722-1082) or send a message for our scheduler, and we can set up an appointment.

-Nurse Mark
[ Attachments
_— Title: Type 2 Diabetes Tips
= Category: Patient Education Pages: 2
Portal: Available in Portal Documents

Last Modified: mark 05/02/19 1:43pm

Remove Attachment View Document

| Add Attachment | No Reply Se‘\d

P
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Attach Documents to Portal Messages

My Kid's Chart

Abigail Addington
Sex: Female

Birthdate: 05/03/09
Last Physical: 12/07/18

Subject: Tips for Getting Started with Diabetes Management?

Thu 05/02/19 2:00pm
Mark Williams, M.D.

Hello,
Our care coordinator can talk with Abigail's grandmother, either
over the phone or you can schedule time to talk in person.

I've attached the handout that we provided at our last appointment.

Call the office (800-722-1082) or send a message for our
scheduler, and we can set up an appointment.

-Nurse Mark

Attachments

= 05/02/19 - Type 2 Diabetes Tips

Thu 05/02/19 1:39pm
Ansel Addington

C Hi Dr.,
P Abigail's grandmother (who watches Abb after school) wanted to
. . . learn what she should know about her diagnosis. Anything useful
Pediatric EHR Solutions to share?

.. . . -Ansel




Add Portal Message Button

[ NN )
== PCCEHR
-] FiND
Abigail Addington ~ PCC# 2503

Medical Summary

Recent and Upcoming Appts
Reminders
Problem List
Outstanding Tasks
Appointment History
Medication History
PCC eRx Allergies
Forms
Family Medical History
Siblings
Confidential Notes

Demographics
History

PCC eRx

Create Visit

E + @ B M

2R B Pediatric EHR Solutions

Medical Summary

PCC EHR

Abigail Addington 10 years

Recent and Upcoming Appointments

Last Visit: 12/07/18 (4m 3w ago) Dr. Casey
Dx: none

Last Physical: 12/07/18 (4m 3w ago)

Next Physical Due: 12/13/19

Scheduled Appts.: none

Reminders No Saved Notes

Problem List Modified 04/22/19

Status | Problem |
Active Scoliosis Idiopathic (737.30)

Diabetes Mellitus Type I(juvenile type),
not stated as uncontrolled (250.01)

Display: All Statuses v
Problem Note | Onset |Resolved

Active

Outstanding Tasks
There are no outstanding Tasks

Appointment History 1-70f7
Date |

12/07/18 2:30pm Fri

Reason | Provider \ Location | Removal Reason

8yr - 9yr Well Visit Elizabeth Casey, MD Winooski Pediatrics

11/09/18 5:00pm Fri  Flu Vaccine Winooski Pediatrics
10/12/18 1-ASnm Fri  Sick Call Mark Wijliaaas40 saasliDediatrics
Edit Add Phone Note Close Save Save + Exit
i @6l © —

Signed in: mark at Winooski e

5/03/09 F

a
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Documents From Parents/Patients in
Patient Portal

e Parents/Patients can attach PDF or JPG files to patient
portal messages
e These documents will appear attached to the portal

message in Messaging screen
:

/[ B\

PCC
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Parent/Patient Attaches Document

Back My Kid's Chart

This message service is intended for non-critical questions only! If you require assistance immediately, please call the office. If you have a medical emergency, call
911.

Patient

Pebbles Flintstone

0
D
7]
=

Message

‘ | am attaching a picture of a rash Pebble's has on her arm after playing outside this afternoon. | am wondering if | need to bring her in, or how to treat it.

a IMG_2637.jpg

Attach a Photo or PDF

PCC
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Document Visible in Messaging Queue

HR | Schedule (11) | Visit Tasks (99+) | E-lab Results (40) | Rx Queue (4) | Messaging (34) [ Signing (99+) |
-] Finp | |
|Date IPatient Subject ITask ITo l"“ D

06/13/17 10:56am Flintstone, Pebbles Portal Message - Rash Portal Message

PCC
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Edit Portal Message Document

Title
[IMG_2637.jpg |

Category
[Portal Message Attachments |:]

@ Attach Document

[06/13/17, Portal Message |v]
There are no orders for this visit.

 File as Unattached Document

Document Date: [:]

[[] Display in the Visit History Index

Needs to be Signed by Provider:

select a provider |v]

[] Display in Portal Documents
Document will be visible to all portal users
attached to the patient

Note (Internal use)

l J

V¥ Tasks

Task:

[*:.e\ef:t a task IL]

To:

E Note:

2R B Pediatric EHR Solutions




Working with the Patient Chart

PCC
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Outstanding Tasks

e The Outstanding Tasks component in the Medical
Summary shows all outstanding tasks for the patient.

e |cons indicate if the task is attached to an order, phone
note or document.

e You can add this component to other sections of the
chart or protocols.

PCC HRIVING
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Outstanding Tasks Component

Medical Summary Rudy Blanchard 1 yr6mos 12/19/16 F

-

Recent and Upcoming Appointments
Last Visit: 07/10/18 (1d ago) Dr. Casey
Dx: none
Last Physical: none
Next Physical Due: none
Scheduled Appts.: none

Reminders  No Saved Notes

Icons indicate whether tasks are associated with orders, documents
or messages. Click on an icon to go directly to the task

Outstanding Tasks [

Tasks ]Date rovider lOrder/Subject [Task ITQ
‘ 0, 18 Elizabeth Mary Casey, MD Immunization - IPV Immunization Needed
B 07/10/18 Document - Records Request Additional Information Needed  Anita Sharp

- 07/05/18 Elizabeth Mary Casey, MD Amendment Request from a Visit Amendment Request

Problem List Modified 07/05/18 Display:| All Statuses v

Status] Problem | Problem Note ] Onset I Resolved
Active [g Attention deficit hyperactivity disorder

PCC T T T e X L)
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Outstanding Tasks Component

File Edit Reports Tools Help

wi= PCC EHR
— sl= PCC EHR Visit History 'Rudy Blan
Orange chart sections and components = 07/10/18 - 18 Mo Well - (client v. ) Bright Futures

help you quickly find outstanding tasks KipolatiiciE Detalle

in the patient’s chart Appt Time:  07/10/18 9:00am

Medical Summary Arrival Time: 07/09/18 2:29pm
. Visit Reason: 18mo Well Visit
5 Demographics Patient Age: 1yr, 6 mos
Reminders History Location: Winooski Pediatrics
Outstanding Tasks Provider:  Elizabeth Mary Casey, MD
- Visit History
Problem List —— i i
Immunization History c,"CK on an icon to go $
Medication History B directly to the task v. 1) Bright Futures
P Rx Allergi 7 5
£C chx Bllargies Growth Charts ntake Hover your mouse over each icon to get details about
Family Medical History Documents the task(s) associated with a visit =
Care Plan SRR it flistory Index Display: | Al
L g Protocols Details
ghings # = 07/10/18 1y 6m 18 Mo Well - (client v. 1) Bright Futures Dx: none
Eqrme 18 Mo Well - (client v. I) Brig... ]
Status Date Document Title Task To

Demographics l

oo |
oo |

Outstanding 07/10/18 Document - Records Request Additional Information Needed Anita Sharp

PCC T!‘ w!ﬁ
CianE
7 T\
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Due Dates for Tasks

e You can add a due date to a task and then use PCC

EHR's tools to track down work that needs to be done
today or later.

e When you create a task, the default due date will be
today. You can change it at any time, and edit orders to

update their due dates.
PCC Pediatric EHR Sol /T:'c!%%',él'é’ﬁ
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Due Dates for Tasks

Followup

EDITING | ) call to Schedule Followup @ Ordered

Result: | enter result notes
| want my staff to call the

Signature Required family on 03/01/2019 to
Include on Patient Reports schedule their followup
¥V Tasks: 1 (0 Completed) /
() Task Appointment Needed v | To|selectauyser K >
" Due|03/01/19 |
Note | enter task notes here v
Task Completed At 12:00am | By
ADD TASK DISCARD CHANGES |  SAVE ORDER

PCC
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Due Dates for Tasks

0@ PCC EHR
.: PCC EHR Schedule (20) = Visit Tasks (1) = E-labResults (1) Rx Queue (0) Messaging (7)  Signing (3)
' - | FND
Tasks: 1
Completed |Date JDue \Patienl ‘Visit Status (Rm.) |Provider \Order \Task [To [™Docs In Use
01/02/19 08:46am 01/17/19 Barr, Kristen Gone Crusher Cardiology Referral Order Unassigned
' By default, the Visit Tasks
queue will only list tasks that
are due or past due
4 »
Task: | Referral Order ~ | Location: All Locations ~  Due: 01/17/19  *“ Display: Not Completed ~
[
Assigned User: All Users rovider: | All Providers v Save My Defaults

Page Up | Page Down Page 1 Open Chart = Edit Order

You can filter the queue. I'm viewing]

all Referral Orders that are due on
or before 01/17/19

PCC

EREEE Pediatric EHR Solutions




Due Dates for Tasks

Medical Summary Taleda M Simmons 3yrs,1mo 11/23/15 F
Outstanding Tasks
Tasks |Date  |Due Provider Order/Subject | Task To
("F") 01/17/19 03/01/19 James Davidson, Jr. M.D. Followup - Call to Schedule Followup Appointment Needed
psc 01/30/1 9\ Referral - Speech Therapy Confirm Outcome
AN

The Outstanding Tasks component
displays the due dates for tasks in
incomplete orders

il

PCC
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Hiding Orders from Patient Reports

e When configuring orders in the EHR it is possible to
hide items from patient reports (patient vis. summary,
health info. summary & patient portal).

o Example: sensitive labs

e When the order is placed, there’s an option to hide for
that patient specifically

e (Changing the default under the configuration /./’

automatically hides that order for every patient i l
PCC, _ THRVING
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Hiding Orders from Patient Reports

Screening Orders - Add Order

Order Name: [Depression Screen

I"Include on Patient Reports" will be selected when this order is issued:
x| Allow this order to be Refused \

(x| Allow this order to be Contraindicated

Lab Configuration

Lab Orders | Common Tests | Lab Facilities |

Edit Lab Order

Lab Order Name: [GC/ChIamydia

Default Lab Facility: [S»E‘Ievtt a lab facility

(%] Enable recording of Specimen Collection user, date and time
[T1"Include on Patient Reports" will be selected when this order is issued:

(%] Allow this order to be Refused -
% Allow this order to be Contraindicated Uncheck this box

Pediatric EHR Solutions
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Hiding Diagnoses & Family Medical
History from Patient Reports

e Diagnoses (both from the problem list and visit note)

can be hidden from patient reports
e Diagnoses and family medical history SNOMED codes

can be hidden from patient reports by default in
Diagnosis Configuration //’

—r

PCC

Pediatric EHR Solutions




Hide Problem List Diagnoses

Problem List *Unsaved Changes Display:[AlI Statuses v
Status Problem Problem Note Onset | Resolved
| fm | Active ~ | Asthma v:
| fm|Active |v|Eczema v
& | Active v [ Pregnancy test positive v
| fm| Active |+ v

PCC Tn'nw!ﬁ
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Hide Family Medical History Diagnoses

Family Medical History *Unsaved Changes

Condition
& [ Acute type B viral hepatitis

@ -

PCC
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Hide Visit Diagnoses

% Disorder of respiratory system
| Refine the diagnosis of Disorder of respiratory system |
ICD-10: J98.9 Respiratory disorder, unspecified
(%] Include on Patient Reports
[notes v
[] Add to Problem List Onset: Problem Note: |problem note ]
e o [ Pregnancy test positive v
[Reﬁne the diagnosis of Pregnancy test positive v]
ICD-10: Z32.01 Encounter for pregnancy test, result positive -
[] Include on Patient Reports
[notes v

ACTIVE ON PROBLEM LIST: ksl Pregnancy test positive

PCC THIIIUING
——— = Pediatric EHR Solutions CHANGE
[ B | / B \



Diagnosis Configuration

4 Edit Diagnosis X
Description: fJ Pregnancy test positive

| Include on Patient Reports

Apply historically throughout all patient charts
x| Favorite - available for selection in the Diagnoses and Problem List components
| Allergy - available for selection in the Allergies component

| Family Hx - available for selection in the Family Medical History component

. Cancel ’ [ Save ]

PCC
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Access Problem List Diagnosis in Visit
e The diagnosis component in the visit will access the

problems on the problem list for selection when
diagnosing the patient in the visit

] well child visit
[Refine the diagnosis of Well child visit [+]

ICD-10: [200.129 Encounter for routine child health examination without abnormal findings
ICD-10: [268.52 Body mass index (BMI) pediatric, 5th percentile to less than 85th percentile for age v]

[notes [~

"] Add to Problem List Onset: |mirr

n/dd/yy | Problem Note: [prob\em note ]

[] |select diagnosis or active problem
‘Bronchiolitis p, — -
Asthma _ lFrom the patient’s problem list
Eczema

18 month examination normal

Lal apdominal bruit

st
[

d Abdomina | colic
[: Abdominal colic in child less than or equal to 12 months @
| Abdominal discomfort

Abdominal | muscle pain
IPr inus '3 i sian | Claca I <ava lﬂavn-l-l:vifl

PCC
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Fenton Preterm Growth Charts

Demographics Train A

e PCCEHR includes the Fenton
preterm growth charts

Patient Demographics

Train Alison A. Sabino Pat_:ien
P Enter the gestational age at First Name: [TrainAlison ] Patient
) ] ) Nickname: [ | Ppcp:
birth in the patient'’s Middle Name:  [A. | ss:
. Last Name: |Sabino | school:
demographics et | At Nan
e |f gestational age <37 wks Date of Birth: [03/24/16 | Chart4
] ] ! _ Sex: | Female M
Fenton charts will display until = peceased: @ No Oves [coic o ]
the patient reaches 50 weeks LG

GA at Birth: ahiE days C—

of gestational age.

i

THRIING
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Fenton Preterm Growth Charts

Growth Charts ‘Train Alison A. Sabino 2 mos, 3 w
4 [Preterm 22 to 50 Weeks GA: Weight-For-Age (Fenton) ]v] »

16
15
14 -
13 | L
12 - s

S
=
o
|-
\
\
\
\
\

Weight (lb
~
1
\\
\

Fenton 2013 Pret

T T T T T T T
22 24 26 28 30 32 34 36 38 40 42 44 46

Gestational Age (Weeks)
V Tabular Data Preterm Weight-For-Age 22 to 50 Weeks GA: Girls Source: Fenton 2013 Pretermg

P‘ ‘ ShowlDatelAgeI Gestational Age IWeightI Percentile

Pediatric EHK Solutions
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Down Syndrome Growth Chart
e If a diagnosis of Down Syndrome is added to the
patient’'s problem list, the Down Syndrome growth
chart will appear automatically.

Medical Summary ‘Train Melissa
Problem List Modified 06/17/16
Status Problem Proble
‘| Active v':PartiaI trisomy 21 in Down's syndrome v

1 reve ] ]

JT“I"“'!G
CHANGE
/ B \
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Down Syndrome Growth Chart

Growth Charts Train Melissa A. Andrews
Down Syndrome 2 to 20 Years: Weight-For-Age (AAP) |:] 1]

220 -
210 -
200 -
190 -
180 - —
170 - -

160 - g

2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1
Age (years)
¥V Tabular Data Down Syndrome Weight-For-Age 2 to 20 Years: Girls Source: AAP#

Show [ Date | Age I Weight I Percentile

il
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Using PocketPCC for Charting

PCC
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Enter Vitals in Pocket PCC

Sick - Bright Futures

Weight
88 Ibs 1 0z (39.940 ko) Appointment Details
- ()
inake
815! percentile (CDC) History
Height Review of Systems

Social/Family History

57 in  (144.78 cm) Physical Exam

82" percentile (CDC) Diagnoses
Temperature ‘Lab
Medical Test
98 |°F Radiology
Medical Procedures
Oral Immunizations
Plan
BMI (Estimated) Forms
Prescriptions
19.1 kg/m? e
Height: 57 in - 07/11/18 Visit Documents

78" percentile (CDC)
Healthy Weight

PCC

More

Pediatric EHR Solutions

Vitals
Weight

Height

\ Ibs |

0z

88 lbsg oz 81 percentilecoey (39.944 kg)

Temperature |

BMI

© More

°F

| Unspecified Method

= ‘

98 °F
Oral

98.4°F

Tympanic

19.1 kg/m? 78" percentileicoc)

Entered by Dr. Casey | <t————

57 in 83 percentilecoe) (144.78 cm)

Healthy Weight

Hover over vitals
to see who
entered them

bt
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Attach Photos to Charts via Pocket PCC

pocketPCC A
rt

pocketPCC =

£

Menu Chart

Medical Summary
Mickey Mouse
10y 4m 08/27/08 Male Mickey Mouse
Family Medical History et ey l 10y 4m 08/27/08 Male

Couerin ooy BN Add Document

Care Plan
Documents

None

Recent and Upcoming Appointmel Attach a Photo or File

Last Visit: 01/18/19 (5d ago) Dr. Cast
Diagnosis: None Add Phone Note

Last Physical: 01/22/19 (1d ago)
Next Physical Due: 01/28/20 Add Portal Message
Scheduled Appointments:

01/23/19 1:45pm Sick Call Crusher Winooski

Mighty Mouse
5m 3w 07/29/18 Male
Minute Mouse

PCC

=1
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Attach Photos to Charts via Pocket PCC

£

Mickey Mouse
10y 4m 08/27/08 Male Attach a Photo or File
P
Attach a Photo or File Va " Edit tags before
Tags Edit saving

B Title: none

JUCAR SRS OF - MM_hand.jpg Date: 01/23/19

upload multiple files -~ .
at one time, up to > Category: Correspondence/Consults
30mb Attached To: 01/23/19 - Sick - Bright Futures, All Orders

Save Document

Title: none

Date: 01/23/19
Category: Correspondence/Consults
Attached To: 01/23/19 - Sick - Bright Futures, All Orders

Save Document

PCC
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Attach Photos to Charts via Pocket PCC

=3 PCC EHR

- | FnD

Mickey Mouse
Medical Summary
Demographics
History
PCC eRx

Visit: 01/23/19
Sick - Bright Futures

Appointment Details
Intake
History
Review of Systems
Social/Family History
Physical Exam
Diagnoses
| Lab
Medical Test
Radiology
Medical Procedures
Immunizations
Plan
Forms

Visit Documents

All Orders

Sick - Bright

PCC#3377 Followup

Futures

Mickey Mouse 10yrs,4mos 8/27/08 M
Order select a referral M=
Order select a followup v
Forms
Generate | School Nurse Meds Admin
Generate | School/PE Excuse
select a form -
Title: none Date: 01/23/19
Category: Correspondence/Consults Pages: 1
Attached to:  01/23/19 - Sick - Bright Futures, All Orders

=
-
s

Previous

Last Modified: elizabeth 01/23/19 4:06pm

View Document

Title:

none Date: 01/23/19
Category: Correspondence/Consults Pages: 2
Attached to:  01/23/19 - Sick - Bright Futures, All Orders

Last Modified: elizabeth 01/23/19 3:24pm

View Document
You can see the photos/ /
files in the chart note

Title: none ; H il “\/i Date: 01/23/19
Category: pocketPCC Files "ngdr;]aetﬁg'tglé%ﬁt t\:/ag;v Pages: 3
Attached to:  01/23/19 - Sick - Bright Futures, All Orders

Last Modified: elizabeth 01/23/19 9:15pm

View Document

Next Billed Sign Close Save

Save + Exit

ol
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Sending Records Electronically

PCC

Pediatric EHR Solutions



Attach Document to Direct Secure Msg

=+ Summary of Care Record ? X

Summary of Care Record

Continuity of Care Document -~
Megan Marcano
May 28, 2010
Female
Document id 79049752-08¢6-44c4-299e-bcaad 2614292
(primary care
Home:
766 Irene Drive
Windsor, VT 05089, US [amnor I v
Tel: 802-555-0199
3088 216.840.1.113883.3.2402.400.100.3 Select a referral or outbound transition of care:
Related to an outbound transition of care v
79049752-08c6-44c4-a99€-bcaad2614292
May 3, 2019, 13:07:45 -0400
_) Print
Save as a PDF file After selecting “Send via Direct Secure
Messaging:”, the “Print” button changes
v Save as a C-CDA file S
ECCER to a “Send to...” button
- © Send via Direct Secure ging: o
Select a referral or outbound transition of care: v
select referral or outbound transition of care v

@ Print
Save as a PDF file
Save as a C-CDA file

Send via Direct Secure Messaging:

THRIING
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Attach Document to Direct Secure Msg

= Direct Secure Message ? X -AiAdd Attachment t 2
. Add Attachment
Direct Secure Message
To: hippocrates-0120@qa0226q2.sdirect.com ¥ Recent Documents (1)
From: Mark Williams, M.D. (mark@ehrdoc.qa.pcc-direct.com) Title: Results
= s Category: Correspondence/Consults Pages: 1
Subject: | Transition of care Last Modified:  mark 05/03/19 1:01pm
Message:
C-CDA and related documentation for Megan Marcano. » Correspondence/Consults (1)
Attachments (maximum 50MB):
Continuity of Care Document (23 KB)
Select a document from the Recent Documents list
or a document category, and click “Attach”

Fill out the To and Subject fields, optionally
add a message, and use the buttons

at the bottom of the dialogue to add

files or documents

Attach File | Attach Docume: Cancel Send

PCC
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Attach Document to Direct Secure Msg

= Direct Secure Message ? X

Direct Secure Message

To: hippocrates-0120@qa0226q2.sdirect.com
From: Mark Williams, M.D. (mark@ehrdoc.qa.pcc-direct.com) i (maximum S0MB):
Subject: [T iti f

s o i Continuity of Care Document (23 KB)
Message:

Remove | Document: Results (178 KB)
C-CDA and related documentation for Megan Marcano.

Attachments (maximum 50MB):
Continuity of Care Document (23 KEB) Click “Attach File" to attach a file from
Remove | Document: Results (178 KB) your workstation or laptop

t '

The document appears under the list of attachments,
with its title and file size Attaeh Document|| Cancel Send

Attach File  Attach Document Cancel Send

PCC
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Immunizations & Inventory

PCC
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Track Imms Admin with Barcodes

i Medical Test o
| Radiology ——{Once you've placed your immunization orders, click “Select Vaccine Lots")
Medical Procedures ‘
‘ Edit ‘ Refuse ‘ © DTaP To: alice
i Edit Alji Refuse \ © Hepatitis A To: alice
| Edit " " Refuse ‘ © Prevnar 13 To: alice
Order Refuse | |select an immunization Z

PCC T!,...!ﬁ
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Track Imms Admin with Barcodes

== Select Vaccine Lots ? X == Select Vaccine Lots ? X
'V Vaccines For Children 'V Vaccines For Children
Insurance and Race as of 01/24/19 Insurance and Race as of 01/24/19
Primary: Health Assurance Healthstyles $10 (Copay $10) Primary: Health Assurance Healthstyles $10 (Copay $10)
Eligibility Status: | select an eligibility status v Eligibility Status: | Medicare (V24) v
The scanner will automatically select the lot. You can
Ready to scan... Ready to scan... also use the drop-down arrows, before or after
scanning, to manually select a lot or open the Lot
Manager
DTaP Select eligibility status, and then DTaP
Lot #: v scan your vials Lot # | HY2G7 (Public VFC) v | Scanned by mark 01/24/19 10:54am
Hepatitis A Hepatitis A
Lot #: v Lot #: | 5953X (Private funds) v | Scanned by mark 01/24/19 10:55am
Prevnar 13 Prevnar 13
Lot # v Lot #: | T94424 (Federal funds) v | Scanned by mark 01/24/19 10:55am
T94424 (Federal funds)
| T94424 (Private funds)
'Open Vaccine Lot Manager
Cancel Save Cancel

THRNING
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View Imms Admin in the Lot Manager

% Immunization Configuration

Immunization Configuration

Lot Manager | Immunization History & Dica
When you select a lot . . ]

Lot Manager

Immunization (CVX) ‘IManufacturer (MVX) |Lot Number |Expiration [Funding Source \

DTaP (20) Aventis Behring L.L.C. (AVB) C3141AA Private funds
ey Jowstomy  [owss  Jovouis Jemmernss

HIB (49) Akorn, Inc. (AKR) UB56789 State funds

HIB (49) Akorn, Inc. (AKR) UB56792 State funds

HIB Unspec (17) Aventis Behring LL.C. (AVB) Uf673AA State funds

HPV (62) Abbott Laboratories (AB) lot number 09/30/19 Federal funds

Hepatitis A (83) GlaxoSmithKline (SKB) 3458dge Other funds

Hepatitis B (08) Unknown Manufacturer (UNK) 268646487665 Unspecified funds

PCC
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View Imms Admin in the Lot Manager

= Immunization Configuration o X

Immunization Configuration
Lot Manager | Immunization History Screen = Diseases

Lot Manager - Edit Lot

Lot Status

Immunization: DTaP cvx: 20 ® Available (Available lots can be selected for immunization orders)

Manufacturer: | Crucell ¥ | MvX: CRU Reserved

Lot Number: 444444 Depleted

Expiration Date: |01/01/19

Funding Source: |Private funds 42

: = e ; ry

Location: Winooski Pediatrics % Adjustment Date: 10/16/18 |12:09pm

b Diluent Adjustment Reason: S t an adjustment reason b
Note:

( ... you see a log of all transactions associated with that lot )

+ New Quantity 95

Vaccine Inventory Transaction Log (Open in Report Library 3
Da;enime “ Reason No‘(e e Patient Name ;atient HeC Patient DOB | Patient Sex Adjll:j)gr‘rg%s:% Adg%:?:':e:a}:{ Balag(;esgsf
?%/02;(1201 2 Decrease - Wasted g::g::; 2 on
otan Akt s DS 3430 4212018 F : "
e g;’:g::ys Marrero, Jordan 3074 10/10/2015 M 1 %
o gereme oms  msme  wa  wmw ¢ .
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Vaccine-Preventable Diseases

e The Immunization History & immunization order
component will list vaccine-preventable diseases

e The disease is added to the immunization section if
diagnosed in a visit or added to problem list

Status Problem e
i | Active ~ | Bronchiolitis x| [Varicella
| Active v |Asthma [Reﬁne the diagnosis of Varicella
_ Active v Eczema ICD-10: BO1.9 Varicella without complication
Active | [Varicellg| [notes
| Active  |v "] Add to Problem List Onset: Problem Note: |problem note

| |

CC |T||lnwm[;
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Vaccine-Preventable Diseases

Varicella 03/29/12

DTaP/HIB 06/28/12

HepB/HIB | 05/26/11 10/25/11
Prevnar 7 | 06/28/12 09/25/12
Ordered
Diseases

Varicella 06/17/16 date unknown

PCC
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EHR Navigation

PCC
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Open Multiple Windows in PCC EHR

< PCCEHR
File Edit Reports Tools Configuration Window Help

-:. PCC EHR \ SCheduIe a7 \ Visit Tasks (99+) = E-lab Results
~| FinD
Visit Status |Room ITasks | [Arrivaﬁl Time  |Last First
Scheduled 8:30am Martin Matthew M.
Scheduled 9:45am Karper Allison L.
Scheduled 10:45am Jones Aleksandra
11:30am Marcano  Megan
Scheduled 2:15pm Higgins P.C Mackenzie "Lexi" Ai
Scheduled 2:45pm Horricks ~ Courtney
Scheduled 3:15pm Spatz Avarie
Scheduled 3:30pm Swartz PA. Lexi Jordyn
Scheduled 3:30pm Leff Il Megan “Lexi" Jean
Use these icons to jump directly to PCC EHR, the Appointment Book]
the Import Documents window, or the Practice Management window
Billing Stalu* All Billing Statuses v ‘

PCC
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Open Multiple Windows in PCC EHR

% Appointment Book

File Edit Reports Tools Configuration Help

Appointment Book PECENR ) Crusher, M.D.
Appointment Book . o
Schedule Appointment | Add Block % ki Pediatrics
Practice Management
= = i~ . Sunday Monday
atient Name FIRd
[Patient N "] 04/28/19
. - +
M sick call v || 15min 2 18:00 2em
Beverly Crusher, M.D. v - —
= e = The “Window" drop-down shows you
wdarent ek only the windows that are currently open
mm/dd/yy v | [12:00am v 4«3 )
Appointment Note £y
8:30 am
Clear Open Chart Details Save
P C C 8:45am :

EREEE Pediatric EHR Solutions




Organize Assigned User Drop Down
List
e Under Tools>User Administration there is a User

Selection List option

e Using this tool you can organize the Assigned User
drop down lists on the visit task & messaging queues
Also impacts Appt Book provider arrangement.

e This organization will not reflect when picking a user//’

INSI VISI
pcc "eee 2 Vet Il
T Pediatric EHR Solutions e‘ﬁﬁﬁﬁ




Organize Assigned User Drop Down
List

User Administration

Users | Roles [ User Selection List

User Selection List
Arrange the sequence of users in the user selection list.
(%] Keep disabled users on bottom

Auto arrange by first name
Manually arrange Find: | b

Enabled |User Name
+/ | Abbott, Joan

/ Agent, Computer

AgentFive, Test

AgentFour, Test
AgentOne, Test
AgentThree, Test
AgentTwo, Test
Astle, Tom
Ballou, Justin

Beagley, Douglas

ANENENESENENSENESEN

Bergeron, Deb

v Blanchard, Jan

Choose the format for how user names should be displayed.

User Name Format: M

EREEE Pediatric EHR Solutions




Configure Visit Statuses

e The Visit Status Configuration tool can be used to:
o Add new visit statuses

o Change the color of visit statuses

o Set which statuses are part of the click rotation on
the schedule screen

f
PCC Pediatric EHR Solutions Jll UG
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Visit Status Configuration Tool

4 Visit Status Configuration E3
Visit Status Configuration

Status Include in the Visit Status Cycle

Bl Ready-Prov v I8

i || wiProvider ¥ o

E Pediatric EHR Solutions

.. . [ Add HDeIete H Edit ]




Add New Visit Status

4 Visit Status Configuration E3
Visit Status Configuration - Add

Button Color: E]
Text Color: ] .

[% Include in the Visit Status Cycle

PCC Pediatric EHR Solutions

.- . Select Color] { Cancel ‘ { save |




Visit Status Options on Schedule
Screen

Visit Status |Room |Tasks Arrival |Time DOB/Sex |Age

Visit Reason |Provider ||

Ready-Prov v B @11:36&5111 8:30am Hamann Train Adam  03/05/12 M 5y 3m  Sick Call Gomez
Arrived v‘ 5,,",': 11:36am| 10:15am Hamann Train Brittany 03/26/06 F 11y 2m Sick Call Casey
" w/Nurse
B Ready-Prov
w/Provider

B Ready-Nurse
I Breastfeeding
B Bathroom

Y

PCC g
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Choose Visit Status Counters in My
Account

Visit Status Counters: | Arrived, Ready-Prov, Ready-Nurse v

x| Arrived
w/Nurse
%/ Ready-Prov
'w/Provider
%| Ready-Nurse
Breastfeeding
| Bathroom
RM

PCC
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Visit Status Counters in the EHR

PCC

g
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Patient Forms & Summaries

PCC
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Generate Form Letters in PCC EHR

e You can add the new Forms component to PCC

EHR as a way to print, save, and/or upload forms
to the Patient Portal.

e Forms can be configured to be pre-populated with
demographic data (and some clinical data)

e Forms can prompt you to enter additional info,
rather than entering handwritten data on forms.

il

PCC Jrcimﬂ
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Generate Form Letters in PCC EHR

File Edit Reports Tools Help

== PCC EHR Medical Summary Pebbles Flintstone 10years 12/22/07 F

= [ FIND Forms =

Generate School/PE Excuse

Generate | Sports Form

Medical Summary

Family Medical History Splct 4 fao ¥
Care Plan Siblings
Recet an Ucoi Ap Dts

Open Chart' Dino Flintstone 4yrs, 2mos 10/31/13 M

iblings Reminders Modified 01/12/18

Remmder.s Headed to regional soccer championships 10/11.
Problem List
Allergies Lost best friend to a neighborhood house fire in 12/10.

PCC eRx Allergies

PCC
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Generate Form Letters in PCC EHR

& Generate Form - Sports Form ? X

What is the patient's HEIGHT:

54"

What is the patient's WEIGHT:

72lb

What is the patient's BLOOD PRESSURE:
|102/61

Enter the date of the patient's most recent Tetanus shot:
8/3/2017

E Cancel || Generate

T Pediatric EHR Solutions




Generate Immunization Forms in
PCC EHR

o PCCEHR - O X
File Edit Reports Tools Help

w= PCC EHR Immunization History Pebbles Flintstone 10 years -11./08/07. F
= l FIND Vaccines | Print =
oA : DTaP 02/11/08 04/19/08 05/19/08 05/11/09 NnNzz
— Tdap.
Medical Summary Hepatitis A |
Demographics Hepatitis B 12/16/07 02/11/08 04/19/08 05/19/08
HIB Unspec | 02/11/08 04/19/08 05/19/08 02/09/09
Visit Hi HEY il
. Influenza | 11/14/10 09/17/16
e ST ! IPV 02/11/08 04/19/08 05/11/09 11/12/12
Growth Charts Menactra MCV4P |
r— MMR 02/09/09 12/08/10

PCC
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Configure Patient Visit Summary

e Tools>Patient Visit Summary Configuration allows your
practice to configure the data that shows on the
printed visit summary

e It's possible to add note components from the visit (e.g.
Plan), so that the notes print on the visit summary

e For those using the patient portal, there’s a Patient
Portal Configuration Tool that allows you to show plﬁ?’

notes on the portal i |
[:.C.C. Pediatric EHR Solutions E‘ﬁﬁﬁ



Configure Patient Visit Summary

4 Patient Visit Summary Configuration

Configure problem notes (2]
[| Display problem notes with problems.

Include checked items on the standard Patient Visit Summary
[%| Demographics

(| patient Name, DOB, Sex, and PCC#

(%] patient Race, Ethnicity, and Preferred Language

(%] Future Appointments and Date of Last Physical

Visit Information

(%] Allergies

[[] Chief Complaint (not configured)
"3»’:\'9':'[ chief complaint component tl |

[%] Clinical Instructions

[Plan - Generic Note] |+

[%| Diagnoses

[%] Immunizations

(%] Labs

(%] Medications @

[x]

(% Orders

[ Cancel ‘ ] Save ]

PCC
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Configure Patient Visit Summary

Visit Summary for 06/17/16

Mark Williams, M.D.
PCC Pediatrics Main Office
Sick - Pirate Peds

Plan

Supportive Care
Lots of fluids, change toothbrush, Tylenol for pain

PCC

Pediatric EHR Solutions




Staying Up-to-Date on Features

PCC
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Designate a “Super Trainer”

e PCC EHR is constantly changing as we add new, exciting
features. We hold weblabs for the new releases before
the update to show the new features and answer any
guestions.

e Designating a person (or a few people) who can attend
the weblabs for each release and then disseminate that

information to your office will help you take advantag;’
of all the new functionality in PCC EHR. JI I{
THRIIN
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Online Documentation

e PCCEHR online documentation is available 24/7 at:

learn.pcc.com
e Stay on top of release documentation by joining PCC

Community or scheduling a regular call with your Client

Advocate.
g
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Wrap Up & Questions
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